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The document applies to the vector network analyzer below: 
 S3631C Vector Network Analyzer (300kHz-3GHz). 

 S3631D Vector Network Analyzer (300kHz-8GHz). 
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Preface 
Thanks for choosing S3631 Vector Network Analyzer produced by Saluki Technology Inc.  

We devote ourselves to meeting your demands, providing the user high-quality measuring instrument and the best after-sales service. 
We persist with “superior quality and considerate service”, and are committed to offering satisfactory products and service for our 
clients. 

Document No. 
S3631-02-01 

Version 
Rev01 2017.02 

Saluki Technology 

Document Authorization 
The information contained in this document is subject to change without notice. The power to interpret the contents of and terms used 
in this document rests with Saluki. 

Saluki Tech owns the copyright of this document which should not be modified or tampered by any organization or individual, or 
reproduced or transmitted for the purpose of making profit without its prior permission, otherwise Saluki will reserve the right to 
investigate and affix legal liability of infringement. 

Product Quality Assurance 
The warranty period of the product is 36 months from the date of delivery. The instrument manufacturer will repair or replace 
damaged parts according to the actual situation within the warranty period. The user should return the product to the manufacturer 
and prepay mailing costs. The manufacturer will return the product and such costs to the user after maintenance. 

Product Quality Certificate 
The product meets the indicator requirements of the document at the time of delivery. Calibration and measurement are completed by 
the measuring organization with qualifications specified by the state, and relevant data are provided for reference. 

Contacts 
Service Tel: 886.2.2175 2930 

Website: www.salukitec.com 

Email: info@salukitec.com 

Address: No. 367 Fuxing N Road, Taipei 105，Taiwan (R.O.C.) 

 

http://www.salukitec.com/
http://www.salukitec.com/
mailto:info@salukitec.com


4 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

Content 
1. PRECAUTIONS ......................................................................................................................................................................................... 8 

1.1. NOTICES ............................................................................................................................................................................................. 8 
1.2. SAFETY ............................................................................................................................................................................................... 8 
1.3. CLEANING NOTES ................................................................................................................................................................................ 9 
1.4. INSTRUMENT SOFTWARE ...................................................................................................................................................................... 9 

2. OVERVIEW .............................................................................................................................................................................................. 10 

2.1. FRONT PANEL .................................................................................................................................................................................... 10 
2.1.1. Front Panel Keyboard ............................................................................................................................................................ 11 
2.1.2. LCD Screen ............................................................................................................................................................................ 14 
2.1.3. Probe Power .......................................................................................................................................................................... 15 
2.1.4. Front USB Port ....................................................................................................................................................................... 15 
2.1.5. Test Port ................................................................................................................................................................................. 15 
2.1.6. Power Switch ......................................................................................................................................................................... 15 

2.2. REAR PANEL ..................................................................................................................................................................................... 15 
2.2.1. GPIB Port ............................................................................................................................................................................... 15 
2.2.2. VIDEO Port ............................................................................................................................................................................ 15 
2.2.3. USB Port ................................................................................................................................................................................ 15 
2.2.4. Ethernet Port .......................................................................................................................................................................... 16 
2.2.5. Power Port and Switch ........................................................................................................................................................... 16 
2.2.6. Reference OUT/IN ................................................................................................................................................................. 16 
2.2.7. Trigger .................................................................................................................................................................................... 16 
2.2.8. Ground Terminal ..................................................................................................................................................................... 16 

2.3. UI ..................................................................................................................................................................................................... 16 
2.3.1. Trace Display ......................................................................................................................................................................... 17 
2.3.2. Entry Bar ................................................................................................................................................................................ 17 
2.3.3. State Bar ................................................................................................................................................................................ 18 
2.3.4. Softkey Zone .......................................................................................................................................................................... 18 

2.4. THREE METHODS OF OPERATION ........................................................................................................................................................ 19 
2.5. BASIC MEASUREMENT PROCEDURES .................................................................................................................................................. 19 

3. SETTING MEASUREMENT CONDITIONS ............................................................................................................................................. 21 

3.1. INITIALIZING PARAMETERS .................................................................................................................................................................. 21 
3.2. SETTING THE SYSTEM Z0 ................................................................................................................................................................... 21 
3.3. SETTING CHANNELS AND TRACES ....................................................................................................................................................... 21 

3.3.1. Setting Channel Display Windows (Layout of Channels) ....................................................................................................... 21 
3.3.2. Setting Trace Display .............................................................................................................................................................. 22 
3.3.3. Active channel ........................................................................................................................................................................ 23 
3.3.4. Active Trace ........................................................................................................................................................................... 23 

3.4. SETTING STIMULUS CONDITIONS ........................................................................................................................................................ 24 

http://www.salukitec.com/


5 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

3.4.1. Setting the Sweep Type .......................................................................................................................................................... 24 
3.4.2. Setting the Sweep Range ...................................................................................................................................................... 24 
3.4.3. Enable/Disable Stimulus Signal Output .................................................................................................................................. 25 
3.4.4. Setting CW frequency of power sweep .................................................................................................................................. 25 
3.4.5. Setting power level of frequency sweep ................................................................................................................................. 25 
3.4.6. Setting the number of points .................................................................................................................................................. 25 
3.4.7. Setting the Sweep Time .......................................................................................................................................................... 26 

3.5. SELECTING MEASUREMENT PARAMETERS ........................................................................................................................................... 26 
3.5.1. S- Parameters ........................................................................................................................................................................ 26 

3.6. SELECTING A DATA FORMAT ................................................................................................................................................................ 26 
3.6.1. Rectangular display formats .................................................................................................................................................. 27 
3.6.2. Polar format ............................................................................................................................................................................ 27 
3.6.3. Smith chart format .................................................................................................................................................................. 28 

3.7. SETTING THE SCALES ........................................................................................................................................................................ 29 
3.7.1. Auto scale .............................................................................................................................................................................. 29 
3.7.2. Manual scale adjustment on a rectangular display format ..................................................................................................... 29 
3.7.3. Manual scale adjustment on the Smith chart/polar format ..................................................................................................... 30 
3.7.4. Other data settings ................................................................................................................................................................. 31 

3.8. SETTING WINDOW DISPLAYS ............................................................................................................................................................... 32 
3.8.1. Maximizing a channel window ................................................................................................................................................ 32 
3.8.2. Maximizing a trace display ..................................................................................................................................................... 32 
3.8.3. Comparing Traces/Performing Data Math .............................................................................................................................. 32 
3.8.4. Labeling a window (Title) ........................................................................................................................................................ 33 
3.8.5. Turn off the information update function of screen ................................................................................................................. 33 

4. CALIBRATION ......................................................................................................................................................................................... 35 

4.1. CALIBRATION TYPES AND CHARACTERISTICS ........................................................................................................................................ 35 
4.2. CHECKING CALIBRATION STATUS ........................................................................................................................................................ 35 

4.2.1. Execution Status of Error Correction for Each Channel ......................................................................................................... 35 
4.2.2. Execution Status of Error Correction for Each Trace .............................................................................................................. 36 

4.3. CALIBRATION PROCESS ...................................................................................................................................................................... 37 
4.3.1. Selecting Calibration Kit ......................................................................................................................................................... 37 
4.3.2. OPEN/SHORT Response Calibration (reflection test) ............................................................................................................ 37 
4.3.3. THRU Response Calibration (transmission test) ................................................................................................................... 39 
4.3.4. 1-Port Calibration (reflection test) .......................................................................................................................................... 40 
4.3.5. One Path 2-Port Calibration ................................................................................................................................................... 41 

5. TRIGGER ................................................................................................................................................................................................. 44 

5.1. SELECTING A TRIGGER MODE ............................................................................................................................................................. 44 
5.2. GENERATING THE TRIGGER ................................................................................................................................................................. 44 

6. DATA ANALYSIS ...................................................................................................................................................................................... 45 

http://www.salukitec.com/


6 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

6.1. ANALYZING DATA ON THE TRACE USING THE MARKER .......................................................................................................................... 45 
6.2. MARKER FUNCTIONS ......................................................................................................................................................................... 45 

6.2.1. Reading Marker Values on Trace ........................................................................................................................................... 45 
6.2.2. Marker Operation ................................................................................................................................................................... 45 
6.2.3. Marker Search ........................................................................................................................................................................ 47 
6.2.4. Marker Function ..................................................................................................................................................................... 56 

6.3. LIMIT TEST ......................................................................................................................................................................................... 58 
6.3.1. Defining Limit Line .................................................................................................................................................................. 60 
6.3.2. Limit line offset ....................................................................................................................................................................... 61 
6.3.3. Turning the limit test ON/OFF ................................................................................................................................................. 62 

6.4. RIPPLE TEST ..................................................................................................................................................................................... 62 
6.4.1. Configuring Ripple Limit ......................................................................................................................................................... 63 
6.4.2. Turning ON/OFF Ripple Test and Result Display .................................................................................................................... 64 

6.5. FIXTURE SIMULATOR .......................................................................................................................................................................... 65 
6.6. TIME DOMAIN ..................................................................................................................................................................................... 68 
6.7. GATING ............................................................................................................................................................................................. 69 
6.8. PERFORMING PARAMETER CONVERSION OF MEASUREMENT RESULTS .................................................................................................. 71 

7. DATA OUTPUT......................................................................................................................................................................................... 73 

7.1. SAVING DATA ..................................................................................................................................................................................... 73 
7.1.1. Overview Save Type ............................................................................................................................................................... 73 
7.1.2. Saving Instrument State ......................................................................................................................................................... 73 
7.1.3. Save Channel ......................................................................................................................................................................... 74 
7.1.4. Save Trace Data ..................................................................................................................................................................... 74 

7.2. SAVE DATA IN TOUTCHSTONE ............................................................................................................................................................. 75 
7.3. RECALL ............................................................................................................................................................................................. 76 

7.3.1. Recall State ............................................................................................................................................................................ 76 
7.3.2. Recall Channel ....................................................................................................................................................................... 77 
7.3.3. Delete State ........................................................................................................................................................................... 78 
7.3.4. Delete All State ....................................................................................................................................................................... 79 

8. OPTIMIZING MEASUREMENTS ............................................................................................................................................................. 80 

8.1. EXPANDING DYNAMIC RANGE ............................................................................................................................................................. 80 
8.1.1. Narrowing the IF bandwidth ................................................................................................................................................... 80 
8.1.2. Turning on Sweep Averaging ................................................................................................................................................. 80 

8.2. REDUCING TRACE NOISE ................................................................................................................................................................... 81 
8.3. IMPROVING PHASE MEASUREMENT ACCURACY .................................................................................................................................... 81 

8.3.1. Electrical Delay ...................................................................................................................................................................... 81 
8.3.2. Phase Offset........................................................................................................................................................................... 81 

8.4. IMPROVE THE MEASUREMENT SPEED ................................................................................................................................................... 81 
8.4.1. Turn Off Update ...................................................................................................................................................................... 81 
8.4.2. Turn Off Correction ................................................................................................................................................................. 82 

http://www.salukitec.com/


7 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

8.4.3. Performing a Segment-by-Segment Sweep ........................................................................................................................... 82 

9. SYSTEM FUNCTION ............................................................................................................................................................................... 85 

9.1. PRINT ............................................................................................................................................................................................... 85 
9.1.1. Print Function ......................................................................................................................................................................... 85 
9.1.2. Save Image To File ................................................................................................................................................................ 85 

9.2. MISC SETUP ...................................................................................................................................................................................... 85 
9.2.1. Ref Source setup ................................................................................................................................................................... 85 
9.2.2. System Correction .................................................................................................................................................................. 86 
9.2.3. Beeper Setup ......................................................................................................................................................................... 86 
9.2.4. Locking the Front Keys and the Touchscreen ......................................................................................................................... 86 
9.2.5. Setup the color of trace .......................................................................................................................................................... 87 
9.2.6. Time Setup ............................................................................................................................................................................. 87 
9.2.7. Touchscreen Calibration ......................................................................................................................................................... 87 

9.3. LAN SETUP ....................................................................................................................................................................................... 88 
9.4. PRESET ............................................................................................................................................................................................ 88 
9.5. FILE MANAGE .................................................................................................................................................................................... 88 

 

 

 

 

http://www.salukitec.com/


8 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

1. Precautions 

1.1. Notices 
 Carefully read through the following safety instructions before putting the Analyzer into operation. 

 The Analyzer must be used only by skilled and specialized staff or thoroughly trained personnel with the required skills and 
knowledge of safety precautions. 

 S3631 is for INDOOR USE only. 

 Determine the grid voltage to fit the equipment requirements of the input voltage before putting the Analyzer into operation. 

 Never use damaged or aging power cord, and do not overhaul the power cord. 

 Never place the power cord near heat sources. 

 The instrument must waterproof strictly and be avoided the fierce collision when moved. Do not hold the front panel, it may 
damage the keyboard and input connector. 

 Immediately stop using when it comes to abnormal phenomenon, such as equipment smoke and smell. Turn off the power 
switch, unplug the power cord and contact a professional service personnel. 

 Unplug the power plug when it is not in use for a long time. 

 Do not disassemble the equipment. Contact Technical Service personnel to maintenance when equipment failure. 

 Any unit or individual without permission, is not allowed to change the structure of the equipment and safety design. 

1.2. Safety 
The following general safety precautions must be observed during all phases of operation, service, and repair of this instrument. 
Failure to comply with these precautions or with specific WARNINGS elsewhere in this manual may impair the protection provided by 
the equipment. Such noncompliance would also violate safety standards of design, manufacture, and intended use of the instrument. 
Saluki Instruments assumes no liability for the customer's failure to comply with these precautions. 

 Ground the Instrument 

To avoid electric shock, the instrument chassis and cabinet must be grounded with the supplied power cable's grounding prong. 

 Do not operate in an Explosive Atmosphere 

Do not operate the instrument in the presence of inflammable gasses or fumes. Operation of any electrical instrument in such an 
environment clearly constitutes a safety hazard. 

 Keep away from Live Circuits 

Operators must not remove instrument covers. Component replacement and internal adjustments must be made by qualified VNA 
maintenance personnel. Do not replace components with the power cable connected. Under certain conditions, dangerous voltage 
levels may remain even after the power cable has been disconnected. To avoid injuries, always disconnect the power and discharge 
circuits before touching them. 

 DO NOT Service or Adjust the Instrument Alone 

Do not attempt internal service or adjustment unless another person, capable of rendering first aid and resuscitation, is present. 

 DO NOT Substitute Parts or Modify the Instrument 

To avoid the danger of introducing additional hazards, do not install substitute parts or perform unauthorized modifications to the 
instrument. Return the instrument to a Saluki Instruments Sales and Service Office for service and repair to ensure that safety 

http://www.salukitec.com/
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features are maintained in operational condition. 

1.3. Cleaning Notes 
 Keep the instrument cleaning. 

 Turn off the instrument and plug off Power Cable before cleaning. 

 Clean the cover of instrument with a soft, dry cloth. 

 DO NOT spray liquid against the instrument, it may damage the device. 

1.4. Instrument Software 
 Update Pre-install software 

Do NOT update Pre-install software, only when Saluki recommended. Read the chapter of Software Upgrade before install any 
software. 

 DO NOT Modify or Reconfigure the Operating System 

The Microsoft Windows operating system (Windows XP or Windows 7 Embedded) has been modified and optimized by Saluki to 
improve the performance of the VNA. Do NOT install a standard version of the Windows operating system on the VNA. Do NOT 
change advanced performance settings or group policies. Do NOT add or delete any hard disk drive partitions on the VNA. Do NOT 
change the settings of Standards and Formats in Regional Options and Languages from default setting (English). 

 Install Antivirus Protection 

The VNA does NOT have antivirus protection when shipped. Use of an antivirus program is strongly recommended if the user connect 
the VNA to the LAN (Internet). 

In addition, the use of a firewall could help to protect the VNA from viruses. 

 DO NOT Installing user application software 

It is not recommended to install user application software, because some software may affect the speed of measurement, and even 
the normal operation of the instrument. 

http://www.salukitec.com/
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2. Overview 
This chapter will introduce the appearance, UI and typical operations of S3631 VNA. 

2.1. Front Panel 

 
Figure 1: Front Panel 

http://www.salukitec.com/
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2.1.1. Front Panel Keyboard 

 

Figure 2: Front Panel Keyboard 

2.1.1.1. ACTIVE CH/TRACE Zone 
A group of keys for selecting active channels and traces. 

Key Name Description 

Channel Prev Selects the previous channel as the active channel. 

Channel Next Selects the next channel as the active channel.  

Trace Prev Selects the previous trace as the active trace. 

Trace Next Selects the next trace as the active trace. 

http://www.salukitec.com/


12 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

2.1.1.2. MKR/ANALYSIS Zone 
 

Key Name Description 

Marker Displays the Marker Menu on the right side of the screen. User can add/edit/delete markers via the Marker Menu. 
Each trace can have max 15 normal markers and 1 reference marker. 

 Marker Search Displays the Marker Search Menu on the right side of the screen, allows the user to move markers to a specific 
position (maximum, minimum, peak, and a point with a target value) on a trace. Parameters of max. 6 markers will be 
display on screen  

Marker Fctn Displays the Marker Function Menu on the right side of the screen. User can easily take the marker as a reference to 
move the trace. 

Analysis Displays the Analysis Menu on the right side of the screen, provides analysis functions like Fault Point Allocation, SRL, 
and Limit line 

2.1.1.3. INSTR STATE Zone 
 

Key Name Description 

F1 Passive components measuring shortcuts 

F2 Active components measuring shortcuts 

SYSTEM System settings, print, screenshot etc. 

SAVE Displays the Save Menu on the right side of the screen. Save the configurations, calibration data, and trace data to 
storage device. 

RECALL Displays the Recall Menu on the right side of the screen. Recall the configurations, calibration data, and trace data. 

PRESET Preset the instrument to default status. 

http://www.salukitec.com/
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2.1.1.4. RESPONSE Zone 

Key Name Description 

Channel Max 

Changes between normal and maximum display of the active channel window. In normal display, all of the 
defined channel windows (both active and non-active) are displayed in split views on the screen. In maximum 
display, only the active channel window is displayed over the entire area, with non-active windows not be 
displayed. Double-click the channel window can also maximize the window. Even the inactive channels are not 
displayed, measurements of these channels are still going on. 

Trace Max 

Changes between normal and maximum display of the active trace window. In normal display, all of the defined 
channel windows (both active and non-active) are displayed in split views on the screen. In maximum display, 
only the active trace window is displayed over the entire area, with non-active windows not displayed. 
Double-click the trace window can also maximize the window. Even the inactive traces are not displayed, 
measurements of these traces are still going on. 

Meas 
Displays the Measurement Menu on the right side of the screen. Manipulating the Measurement Menu enables 
the user to specify the measurement parameters (types of S-parameters) for each trace. 

Format 
Displays the Format Menu on the right side of the screen. Manipulating the Format Menu Enables the user to 
specify the data format (data transformation and graph formats) for each trace. 

Scale 
Displays the Scale Menu on the right side of the screen. Manipulating the Scale Menu Enables the user to 
specify the scale for displaying a trace (magnitude per division, value of the reference line, etc.) for each trace. 
the user can also specify the electrical delay and phase offset for each trace. 

Display 
Displays the Display Menu on the right side of the screen. Manipulating the Display Menu Enables the user to 
specify the number of channels and the channel window array, the number and arrangement of traces, the 
setup for data math, etc. 

Avg 
Displays the Average Menu on the right side of the screen. Manipulating the Average Menu Enables the user 
to set averaging, smoothing, and IF bandwidth. 

Cal 
Displays the Calibration Menu on the right side of the screen. Manipulating the Calibration Menu Enables the 
user to turn the calibration and error correction on/off and change definitions for calibration kits. 

 

http://www.salukitec.com/
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2.1.1.5. STIMULUS Zone 

Key Name Description 

Start 
Displays the data entry bar for specifying the start frequency of the sweep range in the upper part of the 
screen.  

Stop 
Displays the data entry bar for specifying the stop frequency of the sweep range in the upper part of the 
screen.  

Center 
Displays the data entry bar for specifying the center frequency of the sweep range in the upper part of the 
screen. 

Span Displays the data entry bar for specifying the span width of the sweep range in the upper part of the screen.  

Sweep Setup 
Displays the Sweep Setup Menu on the right side of the screen. Manipulating the Sweep Setup Menu Enables 
the user to specify the output power level, sweep time, number of points, sweep type, etc. 

Trigger 
Displays the Trigger Menu on the right side of the screen. Manipulating the Trigger Menu Enables the user to 
specify the trigger mode and trigger source. Each channel can be set separately. 

2.1.1.6. Navigation Zone 

Key Name Description 

 Knob 

(turned clockwise or counterclockwise) 

Moves the soft-key selection (highlighted display) up or down. Increases or decreases the numeric value in the data 
entry area in step. 

 

 

Moves the soft-key selection (highlighted display) up or down. Increases or decreases the numeric value in the data 
entry area in large steps. 

 
Displays the soft-key menu one layer below. Moves the cursor (|) in the data entry area laterally back and forth. Use 

it together with the ENTRY Block keys to change data one character at a time. 

 Press Knob or Enter key 
Executes the function of the selected soft-key. Finishes the entry in the data entry area and moves the focus to the 

soft-key menu. 

2.1.1.7. Entry Zone 

Key Name Description 

0, 1, 2, 3 … 9, . Keys (numeric keys) Type numeric characters or a decimal point at the position of the cursor in the data entry area. 

+/- +/- alternately changes the sign (+, -) of a numeric value in the 

G/n、M/u、k/m、x1 
Adds a prefix to the numeric data typed by using the numeric key and +/- key and then enters that data. One of 
the two prefixes written on the surface of the key is automatically selected depending on the parameter to be 
entered. x1 is entered without a prefix. 

Entry Off Turns the menu display on/off. 

Bk Sp Backspace key. 

ESC Quit the current operation. 

Help - 

2.1.2. LCD Screen 

http://www.salukitec.com/
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S3631 is equipped with a 10.4-inch TFT color, touch LCD screen for displaying traces, scales, settings, soft-keys and other 
measurement related information. The touch screen LCD allows the user to manipulate soft-keys by touching the LCD screen directly. 

2.1.3. Probe Power 
DC power output. The 2 ports are used to power up the active DUT. The 2 ports need to be customized and need input (DC power, 
DC current) from user. 

2.1.4. Front USB Port 

Two USB (Universal Serial Bus) ports are provided that can be used for connecting to USB keyboard/mouse, USB storage or a 
printer.  

2.1.5. Test Port 
To be connected to DUT, cal kit. 

2.1.6. Power Switch 
Turn on/off the instrument. 

2.2. Rear Panel 

 
Figure 3: S3631 Rear Panel 

2.2.1. GPIB Port 
The connection to an external controller through General Purpose Interface Bus (GPIB) connector allows the user to configure an 
automatic measurement system. 

2.2.2. VIDEO Port 
The video interface can be connected to an external color monitor (display device). 

Connector type: 15-pin VGA connector, female 

 

2.2.3. USB Port 

http://www.salukitec.com/
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One USB port is provided on the rear panel to connect to USB mouse/keyboard, USB storage or a printer 

2.2.4. Ethernet Port 
Connect S3631 to LAN (Local Area Network). Connecting this instrument to LAN enables user to access the hard disk drive of this 
instrument from an external PC. 

2.2.5. Power Port and Switch 

Power cable is provided as standard accessory of the instrument. Connect the female end of the power cable to the power port. Keep 
the switch off (“O”) before connect the instrument to power source. When power is stabled connected, turn the switch on (“|”). 

2.2.6. Reference OUT/IN 
Ref In port is used to connected to an eternal reference signal. With a high-quality reference signal, user can make a more accurate 
and stable measurement. 

Ref out port can output a 10MHz signal for other devices. 

2.2.7. Trigger 

This BNC female connector allows external trigger to be applied. 

2.2.8. Ground Terminal 
Connect S3631 to a proper ground. 

2.3. UI 

 

Figure 4: S3631 UI 
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2.3.1. Trace Display 

 

Figure 5: Trace Display 

Windows for displaying traces. Because a channel corresponds to a window, it is called a channel window. When the outer frame 
of a channel window is displayed in light gray, the channel is the active channel (the channel for which setup is being performed). In 

above figure, Channel 1 (the upper window) is the active channel. To make a channel active, use  or 

 key. Clicking inside a channel window will also make the channel active. 

2.3.2. Entry Bar 
Used to enter numeric data into the S3631. Press a hardkey or soft-key to enter data, and the data entry bar will appear at the top of 
the screen. To assign a title to a channel window, an entry bar that allows the user to enter letters and symbols by using the front 
panel keys or mouse is displayed instead. 

 

Figure 6: Entry Bar 

 Description 

Displays the name of the parameter for which data will be entered. 

 Data Entry Area 

http://www.salukitec.com/
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When the data entry bar is displayed for the first time, the current settings are displayed on it. the user can change numeric values by 
typing from the keyboard or in the ENTRY block on the front panel. 

The user can hide the frequency information in order to ensure its confidentiality or for other reasons. For detailed information, see 
Hiding Softkey's Frequency Information. 

 Step Button (Small) 

Increases or decreases the numeric value in the data entry area in small steps. Use the mouse to manipulate this button. 

 Step Button (Large) 

Increases or decreases the numeric value in the data entry area in large steps. Use the mouse to manipulate this button. 

 Enter Button 

After typing numeric values in the data entry area by using the keyboard or the numeric keys in the ENTRY Block on the front panel, 
press this button to finish the entry. Use the mouse to manipulate this button. 

 Cancel Button 

Closes the data entry area (turns off the display). Use mouse to manipulate this button. 

2.3.3. State Bar 
Displays the measurement status of the S3631. 

READY Instrument normal 

NOT READY Instrument unnormal 

2.3.4. Softkey Zone 
A group of keys on the screen called by the soft-keys and menu bars. the user can manipulate these keys by using the 
NAVIGATION zone keys on the front panel, the mouse, or the keyboard. User can also use the touch screen instead of keyboard or 
mouse. 

http://www.salukitec.com/
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Figure 7: Soft Keys Zone 

Pressing Knob  or Enter key on the front panel or pressing Enter key on the keyboard causes the highlighted (selected) soft-key 

to be executed. the user can change which soft-key in the menu is highlighted by turning or pressing  on the front panel. 

Pressing the key  or  on the front panel brings up the upper level soft-key menu, and pressing the  or  
key on the front panel brings up the lower level soft-key menu. 

2.4. Three Methods of Operation 
The user can operate the S3631 using one of three operating methods: using keys on the front panel, using a mouse and keyboard, 
and using the touch screen. 

2.5. Basic Measurement Procedures 
To better understanding how to use the S3631, this section describes the basic measurement procedure using the S3631. 
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Figure 8:Basic Measurement Flow 
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3. Setting Measurement Conditions 

3.1. Initializing Parameters 

1. Press  on the front panel or Execute the :SYST:PRES command 
2. Press OK 

3.2. Setting the System Z0 
The procedure for setting the system characteristic impedance (Z0) is as follows: 

1. Press Cal key, or  on the front panel. 
2. Click System Z0, then input the system Z0. 

3. Press . 

3.3. Setting Channels and Traces 

3.3.1.  Setting Channel Display Windows (Layout of Channels) 
The procedure for setting the window layout is as follows: 

1. Press Display key or on the front panel. 
2. Press Allocate Channels key. 
3. Press the desired soft-key to select the window layout shown below. 
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Figure 9: Channel Windows Layout 

3.3.2. Setting Trace Display 

1．Setting the number of traces the procedure for setting the number of traces is as follows: 

1) Press  or  to select the channel for which the user want to set the number of traces. 

2) Press . 

3) Click Number of Traces key. 

4) Press the desired soft-key to set the number of traces. 

2．Setting trace layout (graph layout) 

The procedure for setting the graph layout is as follows: 

1) Press  or  to select the channel for which the user want to set the graph layout. 

2) Press  

3) Click Allocate Traces. 

4) Press the desired soft-key to select the graph layout shown below. 
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Figure 10: Trace Graph Layout 

3.3.3. Active channel 
The active channel is the one whose settings can currently be changed. The window frame of the active channel is displayed brighter 
than the window frames of the other channels. To change the settings specific to a certain channel, the user must first activate the 
channel. 

To change the active channel, use the following hardkeys: 

Hardkey Function 

 
Change the active channel to the next channel with the larger channel number. 

 
Change the active channel to the previous channel with the smaller channel number. 

3.3.4. Active Trace 
The active trace is the one whose settings can currently be changed. The trace name on the screen (for example, Tr3) of the current 
active trace is highlighted. To change the settings specific to a certain trace, the user must first activate the trace. 

To select the active trace, use the following hardkeys: 

Hardkey Function 

 
Change the active trace to the next trace with the larger race number. 

 
Change the active trace to the previous trace with the smaller trace number. 
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3.4. Setting Stimulus Conditions 

3.4.1. Setting the Sweep Type 
The user can select the sweep type from the following four types. 

SoftKey Description 

Linear Sweeps frequencies in linear scale. 

Log Sweeps frequencies in logarithmic scale. 

Segment Performs a sweep with linear sweep conditions (segments) combined. For more information, refer to 
Performing a Segment-by-Segment Sweep (segment sweep). 

Power Sweeps power levels in linear scale. 

The procedure for selecting the sweep type is as follows: 

1. Press /  keys to select the channel for which t h e  u s e r  want to set the sweep type. 

2. Press . 
3. Click Sweep Type. 
4. Press the desired soft-key to select the sweep type. 

3.4.2. Setting the Sweep Range 

1． Setting the Sweep Range with the Lowest and Highest Values 

1) Press /  keys to select the channel whose sweep range will be set. 

2) Press  , then input the lowest value. 

3) Press  , then input the highest value. 

2．Setting the Sweep Range with the Center Value and a Span 

1) Press /  keys to select the channel whose sweep range will be set. 

2) Press  , then input the center value. 

3) Press  , then input the span value. 

3．Setting the Sweep Range Using the Marker 

1) In the channel window whose range must be set, place the active marker The marker on a trace that can be repositioned 
either by front panel controls or by programming commands on the active trace to a position that corresponds to the new 
range (to the lowest, highest, or center value). 

2) Press  key. 

3) Click the soft-key that corresponds to each value. 

SoftKey Function 

Marker → Start Sets the lowest value to the stimulus value of the active marker on the currently active trace. 
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Marker → Stop Sets the highest value to the stimulus value of the active marker on the currently active trace. 

Marker → Center Sets the center value to the stimulus value of the active marker on the currently active trace. 

3.4.3. Enable/Disable Stimulus Signal Output 
The user can turn on/off the stimulus signal output, but this will prevent the user from performing measurement. Therefore, the user 
will not normally use this feature. This is mainly used to turn the output back to on after it has been turned off by the power trip 
feature. 

Follow these steps to turn the stimulus signal output on/off: 

1. Press  key. 
2. Click Power > RF Out (Each press toggles between on/off). 

3.4.4. Setting CW frequency of power sweep 

The procedure for setting the fixed frequency (CW frequency) at the power sweep is as follows: 

1. Press /  keys to select the desired channel. 

2. Press  key. 

3. Click Power -> CW Freq, then enter the fixed frequency. 

3.4.5. Setting power level of frequency sweep 
The procedure for setting power level is as follows: 

1. Press /  keys to select the desired channel. 

2.  Press  key. 
3. Click Power  
4. Click Power in submenu 
5. Enter the power level 
The user can use the power slope feature to correct the attenuation of a power level so that it is simply proportional to the frequency 
(attenuation due to cables and so on ),which improves the accuracy of the level actually applied to the DUT. 

1．Turning power slope feature on/off 

1. Press /  keys to select the desired channel. 

2. Press  key. 
3. Click Power > Slope [OFF] (Slope [ON]). Each press toggles between on/off.  

2．Setting correction coefficient 

1. Press /  keys to select the desired channel. 

2. Press  key. 
3. Click Power > Slope Data [xxx dB/GHz] ("xxx" represents the current set value.). 
4. Enter the correction coefficient using the ENTRY block keys on the front panel. 

3.4.6. Setting the number of points 
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The number of points is the number of data items collected in one sweep. It can be set to any number from 2 to 10001 for each 
channel independently. 

1. To obtain a higher trace resolution against the stimulus value, choose a larger value for number of points. 
2. To obtain higher throughput, keep the number of points to a smaller value within an allowable trace resolution. 
3. To obtain higher measurement accuracy after calibration, perform calibration using the same number of points as in actual 

measurements. 
The procedure for setting the number of points is as follows: 

1. Press /  keys to select the desired channel. 

2. Press  key. 
3. Click Points, then input the desired number of points. 

3.4.7. Setting the Sweep Time 
The sweep time is always kept to the shortest time possible with the current measurement conditions. There is no need to set. 

3.5. Selecting Measurement Parameters 

3.5.1. S- Parameters 
S-parameters (scattering parameters) are used to evaluate how signals are reflected by and transferred through the DUT. An 
S-parameter is defined by the ratio of two complex numbers and contains information on the magnitude and phase of the signal. 
S-parameters are typically expressed as follows: 

 S out-in 

 Out: port number of the DUT from which the signal is output  

 In: port number of the DUT to which the signal is input 

For example, S-parameter S21 is the ratio of the output signal of port 2 on the DUT with the input signal of port 1 on the DUT, both 
expressed in complex numbers. 

Operating Procedure: 

4. Press  (or  ) and  (or ) to select the trace for which 
measurement parameters will be set up. 

5. Press . 
6. Click a soft-key that corresponds to the desired measurement parameter, such as S11, S21, S12, S22. 

Note: There are only S11,S21 parameters for S3631A. 

3.6. Selecting a Data Format 
The S3631 allows t h e  u s e r  to display measured S-parameters by using the following data formats. The data format can be 
preset to factory settings using the Preset option. 

 Rectangular display formats 

 Polar format 

 Smith chart format 
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3.6.1. Rectangular display formats 
Rectangular display formats draw traces by assigning stimulus values (linear scale) to the X-axis and response values to the Y-axis. 
Eight different formats are available depending on the selection of data for the Y-axis. Eight formats include Log Mag, SWR, 
Phase, Expand Phase, Group Dalay, Lin Mag, Real, Imag. 

Type Y-axis Data Type Y-axis Unit Application Examples 

Log mag Magnitude dB 
Return loss measurement Insertion loss measurement 

(or gain measurement) 

SWR   

(ρ: reflection coefficient) 

(Abstract number) Measurement of standing wave ratio 

Phase 
Phase (displayed in range 

from -180° to +180°) 
Degrees ( ° ) Measurement of deviation from linear phase 

Expanded phase 
Phase (can be displayed 
above +180° and below 

-180°) 
Degrees ( ° ) Measurement of deviation from linear phase 

Group delay 
Signal transfer delays within 

the DUT 
Seconds (s) Group delay measurement 

Lin mag Magnitude (Abstract number) Reflection coefficient measurement 

Real 
Real part of measured 

complex parameter 
(Abstract number)   

Imag 
Imaginary part of measured 

complex parameter 
(Abstract number)   

3.6.2. Polar format 
In the polar format, traces are drawn by expressing the magnitude as a displacement from the origin (linear) and phase in an angle 
counterclockwise from the positive X-axis. This data format does not have a stimulus axis, so frequencies must be read by using the 
marker. The polar format allows users to select one of the following three: 

 Linear magnitude and phase ( ° ) 

 Log magnitude and phase ( ° ) 

 Real and imaginary parts 
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Figure 11: Polar Format 

3.6.3. Smith chart format 

The Smith chart format is used to display impedances based on reflection measurement data of the DUT. In this format, traces are 
plotted at the same spots as in the polar format. The Smith chart format allows users to select one of the following five data groups for 
displaying the marker response values. 

 Linear magnitude and phase ( ° ) 

 Log magnitude and phase ( ° ) 

 Real and imaginary parts 

 Resistance (ohm), Reactance (ohm), and inductance (H) or capacitance (F) 

 Conductance (S), susceptance (S), and capacitance (F) or inductance (H) 

 

Figure 12: Smith Chart Format 
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3.7. Setting the Scales 

3.7.1. Auto scale 
The auto scale function is used to tailor each scale (scale/division and the reference line value) automatically in such a way that 
traces will appear at the proper size on the screen for easy observation. 

1. Single Trace Auto Scale 
1) Follow the procedure below to perform the auto scale function on a specific trace. 

2) Press /  and /  keys to select the trace for which the auto 
scale function will be performed. 

3) Press  . 

4) Click Auto Scale. 

2. Auto Scale on All Traces 

1) Press  

2) Click Auto Scale All 

3.7.2. Manual scale adjustment on a rectangular display format 

For a rectangular display format, four parameters are used to manually adjust the scales. 
 

Adjustable feature Description 

Divisions Defines the number of divisions on the Y-axis. An even number from 4 to 30 must be used. Once set, it is 
commonly applied to all traces displayed in any rectangular format 

within that channel. 

Scale/Division 

(Scale/Div) 

Defines the number of increments per division on the Y-axis. 

The value applies only to the active trace. 

Reference position Defines the position of the reference line. The position must be specified using the number assigned to each 
division on the Y-axis starting at 0 (the least significant) running up to the number of divisions being used (the 
most significant). The position applies only to the active trace. 

Reference line value 

(Reference Value) 

Defines the value corresponding to the reference line. It must be set using the unit on the Y-axis. The reference 
line value applies only to the active trace. 

Manually setting scales on a rectangular display format: 

1. Press  /  keys and / keys to select the trace for which scale features will 
be adjusted. 

2. Press  key. 
3. Select the soft-key that corresponds to the particular feature that needs to be adjusted. 
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Figure 13: Manual scale adjustment on a rectangular display format 

Softkey Function 

Divisions Defines the number of divisions on the Y-axis. 

Scale/Div Defines the number of increments per division 

on the Y-axis. 

Reference Position Defines the position of the reference line. 

Reference Value Defines the value corresponding to the 

reference line. 

3.7.3. Manual scale adjustment on the Smith chart/polar format  
Manual scale adjustment on the Smith chart format or the polar format is done by using the displacement (Scale/Div of the 
outermost circle). 

1. Press /  keys and /  keys to select the trace for which the 
scale will be adjusted 

2. Press key 
3. Click Scale/Div, then input the displacement of the outermost circle. 
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Figure 14: Polar Format 

 

Figure 15： Smith Chart Format 

3.7.4. Other data settings 
1. Electric Delay 

1) Press /  keys and / keys to select the trace for which 
the scale will be adjusted. 

2) Press key. 

3) Click Electric Delay, then input the displacement of the outermost circle. 

2. Phase Offset 

1) Press /  keys and /  keys to select the trace for which 
the scale will be adjusted. 

2) Press  key. 
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3) Click Phase Offset, then input the displacement of the outermost circle. 

3.8. Setting Window Displays 

3.8.1. Maximizing a channel window 
When using multiple channels, it is possible to maximize a specific channel window on the screen. When multiple traces are 
displayed in a channel window, it is also possible to maximize a specific trace displayed within that channel window. 

1. Press  (or  ) to select the channel whose window will be maximized. 

2. Press  to maximize the channel window. 

3. Press  one more time to reduce the window to its previous size. 

3.8.2. Maximizing a trace display 

1. Press  (or ) to select the channel to which the trace belongs. 

2. Press (or ) to select the trace whose display will be maximized. 

3. Press Trace  the trace display. 

3. Press  one more time to reduce the display to its previous size. 

3.8.3. Comparing Traces/Performing Data Math 
Each of the traces for which measured data is displayed is provided with an additional trace, called a memory trace, that temporarily 
stores measured data. the user can use the memory trace to compare traces on the screen or to perform complex data math 
between the memory trace and measured data. 

Performing Data Math Operations: 

1. Press /  keys and  / keys to select the trace for which the 
scale will be adjusted. 

2. Press  key. 
3. Click Data -> Mem to store the measured data in memory. 
4. Click Data Math. Select the data math operation to perform. 

Value Description 

Data/Mem 
Divides the measured data by the data in the memory trace. This function can be used to evaluate the ratio of 
two traces (e.g., evaluating gain or attenuation). 

Data * Memory Multiplies the measured data by a memory trace. 

Data – Memory 
Subtracts a memory trace from the measured data. This function can be used, for example, to subtract a 
vector error that has been measured and stored (e.g., directivity) from data subsequently measured on a 
device. 

Data + Memory Adds the measured data and the data in the memory trace. 

OFF Turn off data math function. 
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5. Click Display. 
6. Select the type of data to display on the screen. 

Softkey  Function 

Data Display only data trace on the screen 

Mem Displays only memory trace stored by Data->Mem operation on the screen. 

Data&Mem 
Displays data trace and memory trace on the screen. the user can now easily compare the data trace and 
memory trace on the screen. 

OFF Trace is not displayed 

3.8.4. Labeling a window (Title) 

It is possible to assign a unique name to a channel and display it on the screen. This feature is useful in saving and/or printing 
measurement result for future reference. Labeling a window: 

1. Press /  keys and  / keys to select the trace for which the 
scale will be adjusted. 

2. Press  key. 
3. Click Edit Title Label,then the title label input dialog box appears. 

4. Press . 
5. Click Title Label to turn on the title display. The title will appear within a frame at the top of the channel window. 

3.8.5. Turn off the information update function of screen 

1. Press  
2. Click Update. 
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Figure 16 : Turn off the information update
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4. Calibration 

4.1. Calibration Types and Characteristics 

Calibration Method Standard (s) Used Corrected Error Factor Measurement Parameters 

No calibration None None All parameters 

Response 
Calibration 

* OPEN or SHORT 
* LOAD 

Following 2 error terms:  
* Reflection Tracking (Er) 
* Directivity (Ed) 

S11(Reflection characteristics at 1 port) 

* THRU 
* LOAD 

Following 2 error terms: 
* Transmission Tracking (Et) 
* Isolation (Ex) 

S21 (1 direction transmission 
characteristics at 2 ports) 

1-Port Calibration 
* OPEN 

* SHORT 
* LOAD 

Following 3 error terms: 
* Directivity (Ed) 
* Source Match (Es) 
* Reflection Tracking (Er) 

S11 (Reflection characteristics at 1 port) 

Enhanced Response 
Calibration 

* OPEN 
* SHORT 
* LOAD 
* THRU 

Following 5 error terms: 
* Directivity (Ed1) 
* Isolation (Ex21) 
* Source Match (Es1) 
* Transmission Tracking (Et21) 
* Reflection Tracking (Er1) 

S11, S21 (1 direction 
transmission/Reflection characteristics 

at 2 ports) 

Full 2-Port 
Calibration 

* OPEN 
* SHORT 
* LOAD 
* THRU 

Following 12 error terms: 
* Directivity (Ed1,Ed2) 
* Isolation (Ex21,Ex12) 
* Source Match (Es1,Es2) 
* Load Match (El12,El21) 
* Transmission Tracking(Et21,Et12) 
* Reflection Tracking (Er1,Er2) 

S11,S21,S12,S22 (All S-parameters at 
2 ports) 

4.2. Checking Calibration Status 

4.2.1. Execution Status of Error Correction for Each Channel 
The user can check the execution status of error correction for each channel with the error correction status. 

The error correction status is indicated in the channel status bar in the lower part of the window by the symbols in the below table. 
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Figure 17:Calibration Status 

4.2.2. Execution Status of Error Correction for Each Trace 
The user can check the status of the error correction actually executed for each trace with the trace status area. 

For a trace for which error correction is executed, the applied calibration type is indicated in the trace status area by the symbols 
in the table below. 

Symbol Calibration Type 

RO Open response calibration 

RS Short response calibration 

RT Thru response calibration 

F1 Enhanced response calibration 

OP 1-port calibration 

F2 Full 2-port calibration/2-port TRL calibration 
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Figure 18: Execution Status of Error Correction for Each Trace 

4.3. Calibration process 

4.3.1. Selecting Calibration Kit 
Before executing calibration, the user need to select a calibration kit. 

If the user use a calibration kit other than a predefined one, the user need to define it. If the connector type of the standard of the 
calibration kit the user use has polarity (the distinction between male and female), the user need to change the standard class 
definition of the calibration kit depending on the standard the user actually use. For more information, see Modifying Calibration Kit 
Definition. 

 Operating Procedure: 

1. Press /  keys to select the channel for which the user want to select the calibration kit. 

2. Press  Key. 
3. Click Cal Kit, then select the calibration kit. 

4.3.2. OPEN/SHORT Response Calibration (reflection test) 
In OPEN or SHORT response calibration, calibration data are measured by connecting an OPEN or SHORT standard, respectively, to 
the desired test port. For frequency response, these calibrations effectively eliminate the reflection tracking error from the test 
setup reflection test using that port. 
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Figure 19: 1-port error model (Open/Short response) 

It is also possible to carry out isolation calibration with a LOAD standard during OPEN/SHORT response calibration. An isolation 
calibration will eliminate the directivity error from the test setup in a reflection test using that port: 

 

Figure 20:1-port error model (OPEN/SHORT response + isolation) 

Operating Procedure: 

1. Press /  keys to select the channel for which the user want to select the 
calibration kit. 

2. Press . 
3. Click Cal Kit to select Calibration Kit. 
4. Click Calibrate. 
5. Click Response (Open)/Response(Short). 
6. Connect a calibration standard (OPEN or SHORT) to the selected test port (connector to which the DUT is to be connected). 
7. Click Open or Short to start the calibration measurement. 
8. If an isolation calibration must be performed using a LOAD standard, follow the Operating procedure : 
9. Connect a LOAD standard to the selected test port (connector to which the DUT is to be connected). 
10. Click Load (Optional) to start the measurement on the LOAD standard. 
11. Click Done to terminate the response calibration (and the LOAD isolation calibration) process. Upon pressing this key, 

calibration coefficients will be calculated and saved. The error correction function will also be automatically Enabled. 
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Figure 21:Connecting standards in OPEN/SHORT Response calibration 

4.3.3. THRU Response Calibration (transmission test) 

In THRU response calibration, calibration data are measured by connecting a THRU standard to the desired test port. This 
calibration effectively eliminates the frequency response transmission tracking error from the test setup in a transmission test using 
that port. 

 

Figure 22:2-Port error model (THRU response) 

It is also possible to carry out an isolation calibration using a LOAD standard in the process of THRU response calibration. An 
isolation calibration will eliminate isolation error (crosstalk error) from the test setup in a transmission test using that port. 

 

Figure 23: 2-port error model (THRU response + isolation) 

Operation Procedure: 

1. Press /  keys to select the channel for which the user want to select the 
calibration kit. 

2. Press . 
3. Click Cal Kit to select Calibration Kit. 
4. Click Calibrate. 
5. Click Response (Thru). 
6. Click Select Ports. 
7. Select the test ports (and corresponding S parameters) upon which a THRU response calibration is to be performed. 
8. Make a between the selected test ports (between the connectors to which the DUT will be connected) 
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9. Click Thru to start the calibration measurement 
10. If an isolation calibration must be performed using a LOAD standard, follow the procedure below. 

 Connect a LOAD standard to each of the two selected test ports (connectors to which the DUT is to be connected). 

 

 Click Isolation (Optional) to start the calibration measurement. 

11. Click Done to terminate the response calibration (and the LOAD isolation calibration) process. Upon pressing this key, 
calibration coefficients will be calculated and saved. The error correction function will also be automatically Enabled. 

4.3.4. 1-Port Calibration (reflection test) 

In 1-port calibration, calibration data are measured by connecting an OPEN standard, a SHORT standard, and a LOAD standard to the 
desired test port. This calibration effectively eliminates the frequency response reflection tracking error, directivity error, and source 
match error from the test setup in a reflection test using that port. 

 

Figure 24：1-Port error model (1-port calibration) 

1. Press /  keys to select the channel for which the user want to select the 
calibration kit. 

2. Press . 
3. Click Cal Kit to select Calibration Kit. 
4. Click Calibrate. 
5. Click 1-Port Cal. 
6. Click Select Port to select a test port (and corresponding S parameter) on which 1-port calibration will be performed. 
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7. Connect an OPEN calibration standard to the selected test port (connector to which the DUT is to be connected). 
8. Click Open to start the calibration measurement. 
If t h e  u s e r  select the calibration kit which has different calibration definitions for each gender, (m) and (f) in the name (label) 
of the standard displayed in the soft-key indicate male (m) and female (f) for the analyzer's connector, respectively. 

9. Connect a SHORT calibration standard to the selected test port (connector to which the DUT is to be connected). 
10. Click Short to start the calibration measurement. 
11. Connect a LOAD calibration standard to the selected test port (connector to which the DUT is to be connected). 
12. Click Load to start the calibration measurement. 
13. Click Done to terminate the 1-port calibration process. Upon pressing this key, calibration coefficients will be calculated and 

saved. The error correction function will also be automatically Enabled. 

 

Figure 25:Connecting the standard for 1-port calibration 

4.3.5. One Path 2-Port Calibration 

Operating Procedure: 

1. Press /  keys to select the channel for which the user want to select the 
calibration kit. 

2. Press . 
3. Click Cal Kit to select Calibration Kit. 
4. Click Calibrate. 
5. Click One Path 2-Port Cal. 
6. Click Select Port to select a test port (and corresponding S parameter) on which 1-port calibration will be performed. 
7. Connect an OPEN calibration standard to the selected test port (connector to which the DUT is to be connected). 
8. Click Open to start the calibration measurement. 
If t h e  u s e r  select the calibration kit which has different calibration definitions for each gender, (m) and (f) in the name (label) 
of the standard displayed in the soft-key indicate male (m) and female (f) for the analyzer's connector, respectively. 

9. Connect a SHORT calibration standard to the selected test port (connector to which the DUT is to be connected). 
10. Click Short to start the calibration measurement. 
11. Connect a LOAD calibration standard to the selected test port (connector to which the DUT is to be connected). 
12. Make a between the selected test ports (between the connectors to which the DUT will be connected). 
13. Click Thru to start the calibration measurement. 
14. Click Done to terminate the One Path 2-Port Calibration process. Upon pressing this key, calibration coefficients will be 

calculated and saved. The error correction function will also be automatically Enabled. 
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Figure 26: One Path 2-Port Calibration 

 

Figure 27:F-2 Calibration (12 error terms) 

Operating Procedure: 

1. Press /  keys to select the channel for which the user want to select the 
calibration kit. 

2. Press . 
3. Click Cal Kit to select Calibration Kit. 
4. Click Calibrate. 
5. Click One Full 2-Port Cal. 
6. Connect the calibration standard to test port x (the connector to which the DUT is to be connected). Upon pressing this key, 

calibration coefficients will be calculated and saved. The error correction function will also be automatically Enabled. 
7. Click Port 1 Open/Short/Load to start the calibration measurement (x denotes the test port to which the standard is connected). 
8. Repeat the above procedure for port y. 
9. Make a THRU connection between ports x and y (between the connectors to which the DUT is to be connected). 
10. Click Thru to start the calibration measurement (x and y denote the test ports between which the THRU connection is being 

made). 
11. Click Done to terminate the One Path 2-Port Calibration process. 
Upon pressing this key, calibration coefficients will be calculated and saved. The error correction function will also be automatically 
Enabled. 
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Figure 28：Full 2-Port Calibration 
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5. Trigger 
The trigger source generates a cue signal that initiates a measurement process. Four types of trigger sources are available. 

Trigger Sources Function 

Internal (Internal) 
Uses a consecutive signal generated by the firmware as a trigger source. Triggers are sent immediately 
following the completion of each measurement. 

External (External) Uses the external trigger input terminal (BNC) or Handler I/O (Pin No. 18) as a trigger source. 

Manual (Manual) A trigger is generated by pressing Trigger > Trigger. 

Bus (Bus) A trigger is generated through GPIB/LAN/USB. 

Operating Procedure: 

1. Press  . 
2. Click Trigger Source. 
3. Click the soft-key that corresponds to the desired trigger source. 

5.1. Selecting a Trigger Mode 
Follow the procedure below to select a trigger mode. 

1. Press /  keys to select the channel for which the trigger mode will be set. 

2. Press . 
3. Press the soft-key that corresponds to the desired trigger mode. Repeat the procedure until each channel is set for its trigger 

mode. 

Hold Sets active channel trigger mode to hold sweep mode 

Single Sets active channel trigger mode to single sweep mode 

Continuous Sets active channel trigger mode to continuous sweep mode 

Hold All Channels Sets all channel trigger modes to hold sweep mode 

Continuous All Channels Sets trigger modes of all displayed channels (Display > Allocate Channels) to continuous sweep mode 

5.2. Generating the Trigger 
Next, it is necessary to generate a trigger by using the trigger source selected in Selecting a Trigger Source. 

1. Pressing  . 
2. Click Restart during a sweep forces the analyzer to abort the sweep.
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6. Data Analysis 

6.1. Analyzing Data on the Trace Using the Marker 

6.2. Marker Functions 
The marker can be used in the following ways: 

 Reading a measured value as numerical data (as an absolute value or a relative value from the reference point) 

 Moving the marker to a specific point on the trace (marker search) 

 Analyzing trace data to determine a specific parameter 

 Using the value of the marker to change the stimulus (sweep range) and scale (value of the reference line) 

The S3631 is capable of displaying up to 16 markers including the reference marker on each trace. Each marker has a stimulus value 
(the value on the X-axis in rectangular display format) and a response value (the value on the Y-axis in rectangular display format). 
The Smith chart and polar formats each have two marker response values (log amplitude and phase). 

6.2.1.  Reading Marker Values on Trace 
The user can read the value of a marker displayed on the trace. 

In rectangular display format, the marker response value is always in the same data format as that of the Y-axis. On the contrary, one 
format for the marker response values (two values: main and auxiliary) can be selected from among several types. The selection is 
performed in the data format. 

Softkey for selecting 
data format 

Marker response value 

Main Auxiliary 

Smith - Lin/Phase Linear amplitude Phase 

Smith - Log/Phase Log amplitude Phase 

Smith - Real/Imag Real component Imaginary component 

Smith - R + jX Resistance Reactance 

Smith - G + jB Conductance Susceptance 

Polar - Lin/Phase Log amplitude Phase 

Polar - Log/Phase Real component Imaginary component 

Polar - Real/Imag Real component Imaginary component 

6.2.2. Marker Operation 

6.2.2.1. Add Marker 
Add marker on the trace. 

1. Press /  keys to activate the channel on which a marker is used. 

2. Press  /  to activate the trace on which a marker is used. 

3. Press . 

http://www.salukitec.com/


46 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

4. Click Add Marker. 
5. Enter the frequency value, and click enter. 

 

Figure 29：Add marker dialog 

6.2.2.2. Remove Marker 

Operating Procedure: 

1. Press /  keys to activate the channel on which a marker is used. 

2. Press  /  to activate the trace on which a marker is used. 

3. Press . 
4. Click Remove Marker 

6.2.2.3. Reference Marker 
The user can convert the marker reading into a relative value from the reference point. 
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Figure 30 Reference Marker 

Operating Procedure: 

1. Press . 
2. Click Reference Marker [ON/OFF]. 

6.2.2.4. Select and Edit Marker 

Operating Procedure: 

1. Press  / keys to activate the channel on which a marker is used. 

2. Press  /     to activate the trace on which a marker is used. 

3. Press  . 
4. Click Select, then click the marker is needed to edit. (Marker1, …, Marker15, Reference Marker) 

5. Enter the stimulus value, and press . 

 

Figure 31: Select and Edit Marker 

6.2.3. Marker Search 
The user can search for a position that matches your specified criteria by using the Marker Search feature. Marker Search allows the 
user to search for a position that matches any of the following criteria. 

1. Maximum value 
2. Minimum value 
3. Target (a point that has a target measurement value) 

 Target nearest to marker position 
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 Target on left-hand side nearest to marker position 

 Target on right-hand side nearest to marker position 

4. Peak 
 Maximum peak (for a positive peak), minimum peak (for a negative peak)  

 Peak on left-hand side nearest to marker position 

 Peak on right-hand side nearest to marker position 

6.2.3.1. Moving markers max 
Operating Procedure: 

1. Press /  keys to activate the channel on which a marker is used. 

2. Press /  to activate the trace on which marker search is used. 

3. Press  . 
4. Click Maximum. 

 

Figure 32:Marker search for maximum 

6.2.3.2. Moving markers min 
Operating Procedure: 

1. Press /  keys to activate the channel on which a marker is used. 

2. Press /  to activate the trace on which marker search is used. 

3. Press  . 
4. Click Maximum. 
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Figure 33: Marker search for minimum 

ATTENTION: When the data format is in Smith chart or polar format, execute the search only for the main response value. 

6.2.3.3. Searching for the target value (target search) 
The target search is a function that searches for a target that matches the pre-defined target value and transition type(s) (positive, 
negative, or both positive and negative) and then moves the marker to that target. 

Target Transition Description 

Positive When the value of the target is larger than the measured value that immediately precedes it (on the left side) 

Negative When the value of the target is smaller than the measured value that precedes immediately it (on the left side) 

Both Both Positive and Negative 

 
Figure 34 Target Transition 

The following three methods are available for executing the target search: 

Search Type Description 

Target search 
The marker moves to the peak with maximum response value if the peak polarity is Positive or Both or to the 
peak with minimum response value if the peak polarity is Negative. 

Search left 
Executes the search from the current marker position to the smaller stimulus values and moves the marker to 
first target encountered. 

Search right 
Executes the search from the current marker position to the larger stimulus values and moves the marker to 
first target encountered. 

 

Figure 35 Type of target search 

Operating Procedure: 
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1. Press /  keys to activate the channel on which a marker is used. 

2. Press /  to activate the trace on which marker search is used. 

3. Press . 
4. Click Target Search > Target Transition. 

5. Click Target Value, enter the target value and press  . 
6. Click Target Value/Search Target Left/Search Target Right to do the search 

 

Figure 36 Target Value 

6.2.3.4. Searching for the peak 
The peak search function Enables the user to move the marker to the peak on the trace. Definition of the peak 

A peak is a measurement point whose value is greater or smaller than the adjoining measurement points on its right and left sides. 
Peaks are classified into the following two types depending on the difference in magnitude from the measurement points on either 
side of it. 

Peak Polarity Description 

Positive peak A peak whose measured value is greater than those of the measurement points on either side of it (peak polarity: positive) 

Negative peak A peak whose measured value is smaller than those of the measuring points on either side of it (peak polarity: negative) 

Both Both positive peak and negative peak 
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Figure 37 Peak Polarity 

Executing a Peak Search 

The following three methods are available for executing the peak search: 

Search Type  Description 

Peak search (Search Peak) 
Moves the marker to the maximum peak when peak polarity is Positive or Both. Moves the marker to the 

minimum peak when peak polarity is Negative. 

Left search (Search Left) 
Executes the search from current marker position to the smaller stimulus values and moves the marker to first 

peak encountered. 

Right search (Search Right) 
Execute the search from current marker position to the larger stimulus values and moves the marker to first 

peak encountered. 

 

Figure 38 Type of Peak Search 

Operating Procedure: 

1. Activate the marker using for the peak search. 

2. Press  . 
3. Click Peak > Peak Excursion. 
4. Enter the lower limit for the peak excursion value. This sets the peak search to be executed based on the definitions of the 

newly set lower limit for the peak excursion value and the currently set peak polarity. 
5. Click Peak Polarity. 
6. Select a peak polarity. This sets the peak search to be executed based on the definitions of the currently set lower limit for the 

http://www.salukitec.com/


52 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

peak excursion value and the newly set peak polarity. 
7. Click the corresponding soft-key to move the marker to the peak. 
8. When the data format is in Smith chart or polar format, execute the search for the main response value of the two marker 

response values 

 

Figure 39 Peak Excursion 

6.2.3.5. Automatically Executing a Search (Search Tracking) 
Search tracking is a function that sets a search to be repeated every time a sweep is done even if the execution key for the search 
(maximum, minimum, peak, and target) is not pressed. This function facilitates observation of measurement results such as the 
maximum value of traces (e.g., the insertion loss of a band pass filter). 

Performing Search Tracking 

1. Press /  keys to activate the channel on which a marker is used. 

2. Press /  to activate the trace on which marker search is used. 

3. Press . 
4. Click Tracking and turn the search tracking function ON/OFF. 

6.2.3.6. Bandwidth Search 
The bandwidth search/ notch search is a function for determining the bandwidth of the trace, center frequency, cut-off points (on the 
higher frequency and the lower frequency sides), Q, and insertion loss, based on the position of the active marker. The definitions of 
the parameters determined through the bandwidth search are shown in below. 
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Figure 40 Value defined as the bandwidth 

 

Figure 41 Value defined as the notch 

Bandwidth Parameter Definition 

Insertion loss (loss) The measured value of the position of the active marker at the time the bandwidth search is executed. 

Lower frequency cut-off point (low) 
Lowest frequency of two measurement points, both separated by the defined bandwidth value from the active 
marker position. 

Higher frequency cut-off point (high) 
Highest frequency of two measurement points, both separated by the defined bandwidth value from the active 
marker position. 

Center frequency (cent) 
Frequency at the midpoint between the lower frequency cut-off and higher frequency cut-off 
points.(high+low)/2 

Bandwidth (BW) The difference in frequency between the higher frequency cut-off and lower frequency cut-off points. (high-low) 

Q Value obtained by dividing the center frequency by the bandwidth.(cent/BW) 
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Executing a Bandwidth Search: 

1. Press /  and /  keys to activate the trace on which the 
bandwidth search is executed. The response value of this active marker itself is the insertion loss in the bandwidth search 
(loss). 

2. Press . 
3. Click Bandwidth Search. 
4. Click Bandwidth Value and enter the defined bandwidth value in the entry area that appears. 
5. Click Bandwidth to turn on the bandwidth search. In the upper left of the trace display, six bandwidth parameters are 

displayed. 

 

Figure 42 Bandwidth search (Data entry dialog) 
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Figure 43 Bandwidth search results 

6.2.3.7. Setting Search Range 
The Marker Search feature allows t he  use r  to set part of the sweep range as the search target (Partial Search feature) as well 
as the entire search range. For the Partial Search feature, the user can select whether to couple traces in the channel. The Marker 
Statistics value is calculated by using the search range. 

Procedure to Set Search Range: 

1. Press /  and /  keys to activate the trace on which the 
bandwidth search is executed. The response value of this active marker itself is the insertion loss in the bandwidth search 
(loss). 

2. Press . 
3. Click Search Range to turn ON the Partial Search feature. 
4. Click Search Start, then enter the start value (lower limit) of the search range. 
5. Click Search Stop, then enter the stop value (upper limit) of the search range. 
6. Click Search Range to turn ON the Partial Search feature. 
7. Click Couple to toggle ON/OFF trace coupling within the search range. 

6.2.3.8. Setting up Markers for Each Trace/Setting up Markers for Coupled Operation between Traces 
Makers can be set up and moved either in coupled operation for all traces in a channel or independently for each trace. 

1. Press /  and /  keys to activate the trace on which the 
bandwidth search is executed. The response value of this active marker itself is the insertion loss in the bandwidth search 
(loss). 

2. Press . 
3. Click Couple to turn the marker coupling on or off. 
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6.2.4. Marker Function 

6.2.4.1. Marker Transfer Settings 
1. Setting the Sweep Range Using the Marker 

1) In the channel window whose range must be set, place the active marker on the active trace to a position that 
corresponds to the new range (to the lowest, highest, or center value). 

2) Press  . 

3) Click the soft-key that corresponds to each value. 

 

Figure 44 Marker 

If the reference marker is on and the stimulus value of the active marker is expressed by a value relative to the reference marker, the 
absolute stimulus value will be used to set the new sweep rang. 

2. Setting the Reference Using the Marker 
1) In the channel window whose range must be set, place the active marker on the active trace to a position that corresponds 

to the new range (to the lowest, highest, or center value). 

2) Press  

3) Click Marker->Reference. 

3. Setting the Delay Using the Marker 
1) In the trace whose reference must be set, place the active marker on the active trace to a position that corresponds to the 

new reference. 

2) Press  . 

3) Click Marker->Delay (Scale>Electrical Delay). 

6.2.4.2. Marker Couple 
Makers can be set up and moved either in coupled operation for all traces in a channel or independently for each trace. 

1. Press /  keys to activate the channel on which the marker couple will be set. 

http://www.salukitec.com/


57 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

2. Press . 
3. Click Couple to turn the marker coupling on or off. 

 

Figure 45 Marker Couple 

6.2.4.3. Listing all Marker Values in all Displayed Channels  

The user can list all of the marker values in all of the displayed channels on the screen. Turning On the Marker Table Display 

1. Press  . 
2. Click Marker Table to turn on the marker table display. 

6.2.4.4. Marker Statistics Data 
The user can easily determine the statistics data for a trace (mean, standard deviation, and peak-to-peak). The definitions for the 
statistics data elements are shown below. 

 

Figure 46 Marker Statistics 

Statistics data element Definition 

Mean (mean) 
 

(n: number of points; xi: measured value at the i-th measurement point) 
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Statistics data element Definition 

Standard deviation (s. dev) 
  

(n: number of points; xi: measured value at the i-th measurement point; mean: Mean) 

Peak-to-peak (p - p) 
Max-Min  

(Max: greatest measured value; Min: smallest measured value） 

Displaying Statistical Data 

1. Press /  and /  keys to activate the trace for which 
statistical data is required. 

2. Press  key. 
3. Click Statistics to turn on the display of statistics data. 

4. Click Statistics Start and Statistics Stop to set the range of Statistics. 

6.2.4.5. Specifying Display Position of Marker Values 
This section describes how to specify the marker value display position for each active trace. 

Operational procedure: 

1. Press /  keys to activate the channel for which the user want to set marker coupling. 

2. Press  key. 
3. Click Annotation Options. 
4. Click Data X Pos to set the horizontal display position. 
5. Click Data Y Pos to set the vertical display position. 

6.2.4.6. Aligning Marker Value Display 
This section describes how to align maker value displays. 

Value Description 

On (Align ON) Displays marker values to align to the display position of trace 1. 

Off (Align OFF) Displays marker values in the display position defined for each trace. 

6.3. Limit Test 
The limit test feature allows the user to set the limit line for each trace and then perform the pass/fail judgment for the 
measurement result. 

The limit test is a function to perform pass/fail judgment based on the limit line the user set with the limit table. 

In the limit test, if the upper limit or lower limit indicated by the limit line is not exceeded, the judgment result is pass; if it is 
exceeded, the judgment result is fail for all measurement points on the trace. Measurement points in a stimulus range with no limit 
line are judged as pass. 

ATTENTION: The targets of the pass/fail judgment are measurement points only. Parts interpolated between measurement points 
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are not judged. 

The user defines the limit line by specifying the stimulus value (Begin Stimulus) and response value (Begin Response) of the begin 
point, the stimulus value (End Stimulus) and response value (End Response) of the end point, and the type (lower limit/upper limit). 
For more information, refer to Defining the limit line. 

When the limit test is on, measurement points that fail are displayed in red on the screen and the trace's pass/fail judgment result 
based on the results of individual measurement points (fail if one or more measurement points on the trace fail) is also displayed. 
the user can check the pass/fail judgment result for the channel (fail if one or more traces fail in any of the limit test, the ripple test or 
the bandwidth test within the channel) on the screen as well. For more information, refer to Displaying judgment result of limit test. 

In addition to viewing the screen, the user can check the judgment result of the limit test by the following methods. 

 

Figure 47 Limit Table 

segment parameter values shown below: 

Segment Parameter Description 

Type 

Select the type of segment from the following: 
OFF Segment not used for the limit test 

MIN Segment at which the minimum is specified 
MAX Segment at which the maximum is specified 

Begin Stimulus Specify starting point for stimulus value on the limit line 

End Stimulus Specify ending point for stimulus value on the limit line 

Begin Response Specify starting point for response value on the limit line 

End Response Specify ending point for response value on the limit line 

ATTENTION: 

 The user can define a limit line that is able to freely overlap the stimulus range of another limit line. 

Defining one limit line having the same type as a second limit line whose stimulus range overlaps with the first one result in two or 
more limit values at the same measurement point. In this case, the limit value to be used in the limit test is defined as follows: 

 When two or more limit values whose type is set to maximum (MAX) exist, the smallest one is used as the maximum. 

 When two or more limit values whose type is set to minimum (MIN) exist, the largest one is used as the minimum. 

 Even if the span of the sweep range on the S3631 is set to 0, enter the two parameters of Begin Stimulus and End Stimulus. 

 When two or more response values are returned as a result of using the Smith or polar chart format, the first response value of 
the marker provides the object of the limit test. 

Measurement points that fail are displayed in red on the screen. The judgment result of the trace is indicated by Pass or Fail 
displayed in the upper right part of the graph. 
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Figure 48 Limit Test 

6.3.1. Defining Limit Line 

To use the limit test, the user must first define the limit line. the user can define a limit table for each trace, and the user can define 
up to 100 limit lines (segments) in a limit table. 

The following steps describe how to define a segment. 

1. Press /  keys and /  keys to select the trace on 
which the limit test function will be used. 

2. Press key to display the Analysis menu. 
3. Click Limit Test to display the soft-keys associated with the limit test. 
4. Click Edit Limit Line to display the limit table. 
5. Click Add to add a segment to the limit table and then specify the segment parameter values shown below. 
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Figure 49 Edit Limit Table 

Softkey Function 

Delete Delete a segment 

Add Add a segment 

Edit Edit the segment 

Clear Limit Table Clear the limit table 

Save Limit Table Open the Save As dialog box. In this step, lim (extension: *.lim) is selected as the file type. 

Restore Limit Table Recall the limit table the user have saved. 

6.3.2. Limit line offset 
By adding a certain offset to the limit value, the  user  can adjust the limit line so that it conforms to the device output. 

1. Press /  keys and /  keys to select the trace on which the 
limit test function will be used. 

2. Press  key to display the Analysis menu. 
3. Click Limit Test to display the soft-keys for the limit test. 
4. Click Limit Line Offsets to display the limit line offset function menu. The following functions correspond to each soft-key. 

http://www.salukitec.com/


62 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

 

Figure 50 Stimulus Offset 

Softkey Function 

Stimulus Offset Adds a certain offset to the stimulus value of the entire segment in the limit table. (Stimulus offset) 

Response Offset Adds a certain offset to the response value of the entire segment in the limit table. (Amplitude offset) 

Marker-> Response Ofs. 
Adds the amplitude offset by the same amount as the retrieved value of the active marker. the user can 
confirm the current value set for the amplitude offset by pressing Amplitude Offset. (Marker amplitude offset) 

6.3.3. Turning the limit test ON/OFF 
The user can set the limit test ON/OFF for each trace individually. 

1. Press /  keys and /  keys to select the trace on which the 
limit test function will be used. 

2. Press  key to display the Analysis menu. 
3. Click Limit Test to display the Limit Test menu. 
4. Click Fail Sign. 
5. Click Limit Line. 
6. Click Limit Test. 

6.4. Ripple Test 
Independently of the limit test, the user can evaluate the measurement results on a pass/fail basis by setting a limit for the ripple. This 
function is called the ripple test. The ripple test is a function for evaluating the results on a pass/fail basis based on the ripple limit, 
which is set using the ripple limit table. the user can specify up to 12 frequency bands, which permits a test for each frequency band. 

The ripple test judges the measurement as "Pass" when the ripple value specified with the ripple limit is not exceeded by any of the 
measurement points on the trace; otherwise, it judges the measurement as "Fail". For the measurement points in a stimulus range 
without a specified ripple limit, the test judges the measurement as "Pass". 
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Figure 51 Result of Ripple Test 

6.4.1. Configuring Ripple Limit 
The user must configure the ripple limit before the user can use the ripple test function. the user can specify a ripple limit table for 
each trace, where up to 12 ripple limit bands (frequency bands) can be configured. 

Operating procedure: 

1. Press /  keys and / keys to select the trace on which the 
user want to apply the ripple test function. 

2. Press  to display the Analysis menu. 
3. Click Ripple Limit to display the soft-keys for to the ripple test. 
4. Click Edit Ripple Limit to display the ripple limit table shown below. 
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Figure 52 Ripple Test Edit Window 

 Softkey Function 

Delete Delete a segment 

Add Add a segment 

Edit Edit the segment 

Clear Ripple Limit Table Clear the ripple limit table 

Save Ripple Limit Table Open the Save As dialog box. In this step, lim (extension: *.rlm) is selected as the file type. 

Restore Ripple Limit Table Recall the ripple limit table the user have saved. 

6.4.2. Turning ON/OFF Ripple Test and Result Display 
The user can set the limit test ON/OFF for each trace individually. 

1. Press /  keys and /  keys to select the trace on which the 
user want to apply the ripple test function. 

2. Press  to display the Analysis menu. 
3. Click Ripple Limit to display the soft-keys for the ripple test. 
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Figure 53 Ripple Limit (Softkeys) 

Softkey Function 

Ripple Test Sets the ripple test ON/OFF. 

Ripple Limit Sets the ripple limit line display ON/OFF. 

Ripple Value 
Sets how the ripple values are displayed. Available settings are off, absolute value (difference between 
maximum and minimum values within the band) display, and margin (difference between absolute value of 
ripple and ripple limit) display. 

Ripple Value Band Selects the band for which the user want to display the ripple value. 

Edit Ripple Limit 
Opens the ripple limit table for editing the ripple limit. To use the ripple test function, the user must first define 
the ripple limit. 

4. Click Ripple Limit to turn on/off the ripple limit function. 
5. Click Ripple Value set how the ripple values are displayed. 
6. Click Fail Sign to show the result of ripple limit. 

6.5. Fixture Simulator 
The Fixture Simulator is a function that uses software in the S3631 to simulate various measurement conditions based on the 
measurement results. The functions available in Fixture Simulator are as follows: 

1. Port reference impedance conversion 
2. Network de-embedding 
3. Embedding 
1. Port reference impedance conversion 
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1) Press /  keys to select the channel on which the user want to use fixture simulator 
function. 

2) Press  . 

3) Click Fixture Simulator to enter the next menu. Click Fixture Simulator to turn ON/OFF the function. 

4) Click Port Z Conversion, enter the next menu. Click Port Z Conversion to turn ON/OFF the function. Click Port1 Z0 to enter 
the Z0 data, click Port2 Z0 to enter the Z0 data. 

 

Figure 54 Port Z Conversion 

2. Network de-embedding 
Network de-embedding is a function for performing measurements, test port by test port, by removing the characteristics of an 
arbitrary network defined by a Touchstone data file. 
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Figure 55 Network De-Embedding 

1) Press /  keys to select the channel on which the user want to use fixture simulator 
function. 

2) Press  . 

3) Click De-Embedding to enter the next menu. 

4) Click Port1 S-parameters File to open S-parameters of simulation data file, click Port2 S-parameters File to open 
S-parameters of simulation data file. 
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Figure 56 De-Embedding (S parameters of simulation data file) 

5) Click Port1 to turn ON/OFF, click Port2 to turn ON/OFF. 

3. Embedding 

 

Figure 57 Embedding 

6.6. Time Domain 
The S3631 provides the time domain function, which is used to mathematically transform waveforms in the frequency domain that 
can be measured with a general network analyzer to waveforms in the time domain. 

The waveform in the frequency domain shows ripples due to mismatches, but it is difficult to estimate their locations. On the other 
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hand, from the waveform in the time domain, the user can determine the locations and magnitudes of mismatches. 

Operating Procedure: 

1. Press /  keys and /  keys to select the trace on which the 
user want to apply the time domain function. 

2. Press  to display the Analysis menu. 
3. Click Time Domain to display the soft-keys for the time domain. 
4. Click Time Domain to turn ON/OFF this function. 
5. Click Start and Stop to set the time range, or Click center and span to set the time range. 
6. Click Type to select the type, including Bandpass, Lowpass Step, Lowpass Impulse. 
7. Click Window to select the shape of window, including Maximum, Normal, Minimum, Impluse Width, KiserBeta. 

6.7. Gating 
Deletes unnecessary data in the time domain from original data in the time domain. For more information, refer to Deleting 
Unnecessary Data in Time Domain (gating). Measurement Flow: 

Item Description 

1. Measurement in frequency domain Executes measurement in frequency domain 

2. Transformation to time domain Enables transformation function and transforms measurement data to data in time domain 

3. Setting the gate Makes the following settings of the gate to select the necessary domain:Gate type, Gate shape, Gate range 

4. Transformation back to frequency 
domain 

Disables transformation function and displays response in frequency domain corresponding to the data 
selected with the gate 

The following figure shows the change in the waveform at each step of the flow. 

 

Figure 58 Change in the waveform at each step of the flow 

1. Setting Gate Type 
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The S3631 lets the user choose from the following two gate types: 

Gate type Description 

Band pass Deletes response outside the gate range 

Notch Deletes response inside the gate range 

Operating Procedure: 

1) Press /  keys and /  keys to select the trace on which 
the user want to apply the gating function. 

2) Press  to display the Analysis menu. 

3) Click gating to display the soft-keys for the gating. 

4) Click Type to select the type, including Bandpass and Notch. 

2. Setting Gate Shape 
The gate is a filter whose shape looks like a band pass filter. There are several parameters that indicate the gate shape. The 
following figure shows the definition of the gate shape parameters. 

 

Figure 59 Gating (the definition of the gate shape parameters) 

The following table compares the characteristics according to the gate shape. 

Gate shape Sidelobe level Minimum gate span 

Minimum -48 dB 2.8/frequency span 

Normal -68 dB 5.6/frequency span 

Wide -57 dB 8.8/frequency span 

Maximum -70 dB 25.4/frequency span 

Operating Procedure: 

1) Press  /  keys and /  keys to select the trace on 
which the user want to apply the gating function. 
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2) Press  to display the Analysis menu. 

3) Click gating to display the soft-keys for the gating. 

4) Click Shape to select the shape of window. 

3. Setting Gate Range 
Specify the gate range in time. The ends of the range are defined as the - 6 dB attenuation points shown in the figure above. 
the user can set the gate range by specifying the start and stop times or the center and span. The S3631 has the following limitations 
on the gate range the user can set. 

Lower limit: -Tspan,  

Upper limit: Tspan 

Tspan is the measurement range expressed in time obtained in Measurement range. 

Operating Procedure: 

1) Press /  keys and / keys to select the trace on which 
the user want to apply the gating function. 

2) Press  to display the Analysis menu. 

3) Click gating to display the soft-keys for the gating. 

4) Click Start and Stop to set the time range, or click center and span to set the time range. 

4. Enabling Gating Function 
Operating Procedure: 

1) Press /  keys and /  keys to select the trace on 
which the user want to apply the gating function. 

2) Press  to display the Analysis menu. 

3) Click gating to display the soft-keys for the gating. 

4) Click Gating to turn ON/OFF the gating function. 

6.8. Performing Parameter Conversion of Measurement Results 
1. The user can use the parameter conversion function to convert the measurement results of the S-parameter (Sab) to the 

following parameters. 
1) Equivalent impedance (Zr) and equivalent admittance (Yr) in reflection measurement 

 
2) Equivalent impedance (Zt) and equivalent admittance (Yt) in transmission measurement 
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3) Inverse S-parameter (1/Sab) 

where: 

Z0a: Characteristic impedance of port a 

Z0b: Characteristic impedance of port b 

4) Z/Y Transmission Shunt 

 
5) Conjugation 

Conjugation converts the measurement value to complex conjugate number. 

When the fixture simulator function is ON and the port impedance function is ON, the value set in the port impedance 
conversion is used. In other cases, the system Z0 (preset value: 50 ohm) is used. 

2. ON/OFF 
Operating Procedure: 

1) Press /  keys and /  keys to select the trace on 
which the user want to use the marker. 

2) Press  to display the Analysis menu. 

3) Click Conversion. 

4) Click Conversion to turn ON the conversion function. 

3. Selecting Conversion Target Parameter 
Operating Procedure: 

1) Press /  keys and / keys to select the trace on which 
the user want to use the marker. 

2) Press  to display the Analysis menu. 

3) Click Conversion > Function. 

4) Click the soft-key corresponding to the parameter to which the user want to convert the result.
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7. Data Output 

7.1. Saving Data 

7.1.1. Overview Save Type 
The user can save the instrument state of the S3631 into a file on mass storage and then recall it later to reproduce that state. the user 
can select the stored data from the following four types. 

Type Stored data and usage 

State only (State Only) 
Saves the setting of the S3631 and reproduces the state when it was saved by recalling it later into the 
S3631. 

State and calibration data (State & Cal) 
Saves the setting of the S3631 and calibration data (calibration coefficient array) to reproduce the state 
when it was saved by recalling it later into the S3631. At this time, the user can perform error correction of 
measured values by using the recalled calibration data. 

State and trace (State & Trace) 
Saves the setting of the S3631 and traces (error-corrected data array and error-corrected memory array) to 
reproduce the state when it was saved by recalling it later into the S3631. At this time, the traces are also 
recalled and displayed on the screen. 

State, calibration data, and traces (All) 
Saves the setting of the S3631, calibration data, and traces to reproduce the state when it was saved by 
recalling it later into the S3631. At this time, the calibration data and traces are also recalled. 

7.1.2. Saving Instrument State 
Operating steps: 

1. Press  key. 
2. Click Save Type. 

3. Press key or key, Save 
4. Click Save State. 

5. Press  , and Choose（State1~State10）, Press key, or Click StateFile, Choose to save state file, Click save 
button. 
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Figure 60 Save State (State Select) 

7.1.3. Save Channel 
The S3631 allows the user to save/recall the instrument state for each channel independently. This function allows the user to 
save the instrument state of the active channel independently into one of four registers (A to D, volatile memory) and to recall the 
instrument state from the register to restore it as the state of the currently active channel. As in the case of saving the entire state 
of the instrument into a file, the user can select items to be saved from four kinds. 

Since t h e  u se r  can recall the instrument state for each channel that was saved with this function from a different channel that 
the one used to save it, this function is very useful for copying an instrument state between channels. 

ATTENTION: Unlike when saving the entire instrument state, the instrument state for each channel is saved into volatile memory 
instead of a file, so if the user turn off the power, this state is lost. 

Operating steps： 

1. Press or Key, to activate a channel whose state the user want to save. 

2. Press Key. 
3. Click Save Channel. 
4. Click one of State A to State D to save the instrument state of the active channel to the specified register. For registers having 

saved data, the “●” symbol is displayed to the right of their soft-key label. If the user specify one of these, its content is 
overwritten. 

7.1.4. Save Trace Data 
The S3631 allows the user to save data for the active trace on the active channel to a CSV file (file extension *.csv) and to load 
the data into PC application software for further processing. 

Procedure: 

1. Press  or  Key and Press or Key to select the trace to be 
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saved. 

2. Press  Key. 

3. Click Save Trace Data to open the Save As dialog box, Select the destination folder and input a file name，Click Save to save 
the file. 

 

Figure 61 Save Trace Data 

7.2. Save Data in ToutchStone 
The user can save data in "log magnitude - angle", "linear magnitude - angle", or "real number - imaginary number." File types are 
*.s1p or *.s2p。The file type indicates the number of ports of the data structure that is output to the Touchstone file. 

Operating Procedure: 

1. Press  or  Key and Press  or  Key, to select the trace 
to be saved. 

2. Press  Key. 
3. Click Save Data To Touchstone File. 

4. Click Type, Choose file types, Click 1-Por（.s1p）, Choose s1p, Click2-Por（s2p）Choose s2p, Selected function button before 
“●”. 

5. Press  Key or  Key, Save Data To Touchstone File. 
6. If choose file type is s1p, Need to choose port, Otherwise, don't need this step operation. Click Select Port, Each click once, On 

a 1, 2 switching. 
7. Click Format, In Touchstone Format, choose file type. File type Shown below: 

Softkey Function 
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Real-Imaginary Select "real - imaginary number" data format 

Magnitude-Angle Select "linear magnitude - angle" data format 

dB-Angle Select "log magnitude - angle" data format 

8. Press  Key or  Key, Return Save Data To Touchstone File. 
9. Click Save File, Open “save as” dialog box, Input to save the filename, Click save. 

 

Figure 62 Save Data in ToutchStone 

7.3. Recall 

7.3.1. Recall State 
Operating Procedure: 

1. Press  Key，Into Recall. 

2. Click Recall State，Into Recall State. 

3. Press  Key，Choose State1~State10（Only the instrument has saved state can choose），Press Key，or Click 
State File，Choose the instrument saved State File 

4. Click Open. Shown below： 

http://www.salukitec.com/


77 

Tel: 886.2.2175 2930 Email: sales@salukitec.com 

www.salukitec.com 
 
 

 

 

Figure 63 Recall State 

7.3.2. Recall Channel 
Operating Procedure: 

1. Press  Key，Into Recall menu. 

2. Click Recall Channel，Into Recall C menu. 

3. Press Key，Click one of State A to State D to save the instrument state of the active channel to the specified 

register，Press  Key，Shown below： 
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Figure 64 Recall Channel 

7.3.3. Delete State 

Operating Procedure: 

1. Press  Key. 

2. Click Delete State，Open Delete State File，Choose to Delete State File，Click Open，Shown below： 
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Figure 65 Delete State 

7.3.4. Delete All State 
Operating Procedure: 

1. Press  Key. 

2. Click Delete All State，Shown below： 

 

Figure 66 Delete All State
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8. Optimizing Measurements 

8.1. Expanding Dynamic Range 
The dynamic range is the finite difference between the maximum input power level and the minimum measurement power level (noise 
floor) of the analyzer. In evaluating a characteristic accompanied by a large change in the amplitude (the pass band and stop band of 
a filter, for example), it is important to increase the dynamic range. 

Lowering the noise floor of the receiver Enables the user to expand the dynamic range. The following methods can be used to lower 
the receiver noise floor. 

1. Narrowing the IF bandwidth 
2. Turning on Sweep Averaging 

8.1.1. Narrowing the IF bandwidth 

Narrowing the receiver IF bandwidth Enables the user to reduce the effect of random noise on measurements. Narrowing the IF 
bandwidth to 1/10 the original bandwidth causes the receiver noise floor to decrease by 10 dB. 

To specify the IF bandwidth, follow the steps described below. 

1. Press  or  Key, to select a channel on which to specify the IF bandwidth. 

2. Press  Key. 
3. Click IF Bandwidth. 
4. Change the IF bandwidth in the data entry area. 

8.1.2. Turning on Sweep Averaging 
Using sweep averaging also Enables the user to reduce the effects of random noise on measurements. Sweep averaging averages 
data from each point (vector quantity) based on the exponential average of a continuous sweep weighted by the averaging factor 
specified by the user. Sweep averaging is expressed in following equation. 

 

Where: 

1. An = Result of the calculation of sweep averaging for the nth sweep operation at the point in question (a vector quantity) 

2. Sn = Measurement value obtained at the nth sweep operation at the point in question (a vector quantity) 
3. F = Sweep averaging factor (an integer between 1 and 999) 
Define the sweep averaging by following the steps below. 

1. Press or Key，select the channel on which the user want to define the sweep averaging. 

2. Press key。 

3. Click Ave Factor 

4. Change the averaging factor in the data entry area.。 

5. Click Averaging to turn on/off the function. 
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8.2. Reducing Trace Noise 
Smoothing can be used to reduce noise that has relatively small peaks. By turning on smoothing, the value of each point on a trace is 
represented by the moving average over the values of several nearby points. The smoothing aperture (percentage of sweep span) 
defines the range of points to be included in the calculation of the moving average. 

Set up the smoothing operation by following the steps below: 

1. Press  or  Key and Press  or  Key，To activate the 
trace on which smoothing will be defined. 

2. Press  Key. 
3. Click Smo Aperture. 
4. Change the Smoothing aperture (%) in the data entry area 

5. Click Smoothing，Turn ON the Smoothing，Be Open Smoothing；Turn OFF the Smoothing，Be turn OFF the Smoothing. 

8.3. Improving Phase Measurement Accuracy 

8.3.1. Electrical Delay 
Electrical Delay is a function that adds or removes a pseudo-lossless transmission line with a variable length corresponding to the 
receiver input. Using this function Enables the user to improve the resolution in phase measurement and thereby measure 
deviation from the linear phase. the user can specify the electrical delay trace by trace. Depending on the media type, the calculation 
method of the electrical delay, which is required to correct the phase delay, differs. 

Operating Procedure: 

1. Press  or  Key and Press or Key，To activate the phase 
trace for which the user want to specify the Electrical Delay. 

2. Press  Key. 

3. Click Electrical Delay. 

4. Change the electrical delay （Entry） in the data entry area. 

8.3.2. Phase Offset 
Phase offset is a function used to add or subtract a predetermined value relative to the frequency to and from the trace. Using this 
function Enables t h e  u s e r  to simulate the phase offset occurring as a result of, say, adding a cable. The phase offset can be 
specified from -360° to +360°.  

Operating Procedure: 

1. Press  or  Key and Press or Key，To activate the phase 
trace for which the user want to specify the Phase Offset. 

2. Press  Key. 
3. Click Phase Offset, Change the Phase Offset(Entry) in the data entry area. 

8.4. Improve the measurement speed 

8.4.1. Turn Off Update 
Operating Procedure: 
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1. Press  Key. 
2. Click Update, State witch to OFF. 

8.4.2. Turn Off Correction 
1. Turn off measure calibration data. 

1) Press  Key. 

2) Click Correction, State witch to OFF. 

2. Turn Off System calibration data 

1) Press Key. 

2) Click Misc Setup. 

3) Click System Correction, Turn ON the System Correction, Be the System Correction; Turn OFF the System Correction, Be 
turn OFF the System Correction. 

8.4.3. Performing a Segment-by-Segment Sweep 

8.4.3.1. Concept of Segment Sweep 
To perform a segment sweep, the user must define two or more frequency ranges, called segments, and then specify the number of 
points, IF bandwidth, power level, sweep mode, sweep delay time, and sweep time for each segment. All segments are swept 
sequentially as if swept in one sweep operation. 

 By skipping the frequency range, which does not need to be measured, the user can sweep and measure only the portions 
the user need. 

 The user can define the optimum measurement conditions for each of the segments the user designate. For example, the user 
can specify as many points as possible in a segment requiring high trace resolution and as few points as possible in a segment 
not requiring high resolution. This shortens the measurement time, Enabling the user to optimize the overall measurement 
throughput by not having to perform the entire operation under the same measurement conditions of a particular frequency 
range. 

To evaluate a band pass filter having the transmission characteristics shown in the following figure. for example, the user can 
select the frequency ranges the user need from A through G and determine the measurement conditions shown in the table below 
This Enables the user to measure them simultaneously in one sweep operation. 

 

Figure 67 Segment Sweep 

No. Start Frequency Stop Frequency Number of points IF Bandwidth Power Delay 

A 440 MHz 915MHz 50 50kHz 0dBm 0s 
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No. Start Frequency Stop Frequency Number of points IF Bandwidth Power Delay 

B 915 MHz 980MHz 130 70kHz 0dBm 0s 

C 980 MHz 1.035GHz 60 50kHz 0dBm 0s 

D 1.035GHz 1.07GHz 60 50kHz 0dBm 0s 

E 1.07GHz 2GHz 100 70kHz 0dBm 0s 

F 2GHz 2.6GHz 40 70kHz 0dBm 0s 

G 2.6GHz 3GHz 40 70kHz 0dBm 0s 

8.4.3.2. Conditions for Setting Segment Sweep 
The following conditions apply when setting up a segment sweep. 

1. The frequency range of a segment must not overlap with that of another segment. (The start frequency of a segment must be 
higher than the stop frequency of the immediately preceding segment). 

2. The start frequency of segment 1 must be greater than lowest frequency and the stop frequency of the last segment less than 
highest frequency, as per the frequency range depending on the option. 

3. When the start frequency and stop frequency of a segment are not the same, the user can define from 2 to 2001 points in a 
segment. 

4. When the start frequency and stop frequency of a segment are the same, the user can define from 1 to 2001 points in a 
segment. 

5. The user can set the total number of points in the segment table from 2 to 2001. 
6. The user can set the number of segments in the segment table to between 1 and 12. 
7. The user can turn ON or OFF segments. 

Data Item Description 

Start Sets the start value of the sweep range 

Stop Sets the stop value of the sweep range 

Points Sets the number of points 

IFBW Sets the IF bandwidth 

POWER Sets the power level 

Delay Sets the sweep delay time 

Operating Procedure: 

1. Press  or  Key, Choose to a new Segment Table data. 

2. Press  Key.  

3. Click Segment Table, Into Segment Table. 

Softkey Function 

Add Add a line in Segment table data 

Delete Delete the last line in Segment table data 

Edit Edit in Segment table data 
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Softkey Function 

List IFBW ON/OFF IFBW 

List Power ON/OFF Power 

List Delay ON/OFF Delay 

 

Figure 68 Segment Sweep 

8.4.3.3. Turning ON/OFF Segments 

Operating Procedure: 

1. Press  or  Key, Choose to The Segment Working trace. 

2. Press Key. 

3. Creating a segment table. 
4. Click Sweep Type. 
5. Click Segment.
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9. System Function 

9.1. Print 

9.1.1. Print Function 
Operating Procedure: 

1. Press  Key. 
2. Click Print. 
3. As necessary, press Invert Image to toggle between [OFF] for printing in colors close to the actually displayed screen and [ON] 

for printing in inverse colors. 
4. Click Print, Shown below, Click “OK” begin to print. 

9.1.2. Save Image To File 

Operating Procedure: 

1. Press  Key. 
2. Click Print. 
3. As necessary, press Invert Image to toggle between [OFF] for printing in colors close to the actually displayed screen and [ON] 

for printing in inverse colors. 
4. Click Save Image to File, shown below, enter the file name, and click Open to save. 

 

Figure 69 Save Image to File 

9.2. Misc Setup 

9.2.1. Ref Source setup 
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Operating Procedure: 

1. Press  Key. 
2. Click Misc Setup. 
3. Click Ref Source, Choose Interal or Choose External. 

9.2.2. System Correction 

The S3631 executes Port Characteristics Correction in the data processing flow shown in Data Processing Flowchart, by using the 
system calibration data set at the factory. This system error correction process is not required if the user performs proper calibration 
by using the Cal key and the soft-keys that subsequently appear, which automatically turns on error correction. 

By turning off system error correction, t h e  u s e r  can reduce the data processing time needed during measurement and thus 
improve measurement throughput. 

Operating Procedure: 

1. Press  . 
2. Click Misc Setup. 
3. Click System Correction to turn ON/OFF the system correction 

9.2.3. Beeper Setup 
The S3631 has a speaker that sounds a beep tone. The beeper allows the user to make two types of settings. 

Type Function 

Operation complete beeper 
Sounds a beep tone to inform the user that operations have completed. 
* When calibration data measurements are done 
* When data storage has completed 

Warning beeper 
Sounds a beep tone to prompt the user to use caution. 
* When an instrument error occurs (An error message appears at the same time.) 
* When a limit test fails 

1. Setting the Operation Complete Beeper 
Operating Procedure: 

1) Press . 

2) Click Misc Setup > Beeper > Beep Complete to switch the operation complete beeper on/off. 

3) Clicking Test Beep Complete allows the user to hear and check the beep tone of the operation complete beeper. 

2. Setting the Warning Beeper 
Operating Procedure: 

1) Press . 

2) Click Misc Setup > Beeper > Beep Warning to switch the warning beeper on/off. 

3) Clicking Test Beep Warning allows the user to hear and check the beep tone of the warning beeper. 

9.2.4. Locking the Front Keys and the Touchscreen 
The user can lock (disable) the front keys and touchscreen. This feature prevents erroneous operation caused by inadvertently touching 
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any of these devices. 

Operating Procedure: 

1. Press . 
2. Click Misc Setup. 
3. Click Keyboard Lock to lock the front keys. 
4. Click Touch Screen Lock to lock the touch screen. 

5. If both keyboard and touch screen are locked, the user  should to press  to unlock them. 

9.2.5. Setup the color of trace 
Operating Procedure: 

1. Press . 
2. Click Misc Setup. 
3. Click Color Setup. 
4. Click trace to select one. 
5. Click Red/Green/Blue to setup the color. 

9.2.6. Time Setup 

Operating Procedure: 

1. Press . 
2. Click Misc Setup. 
3. Click Time Setup to set the time. 
4. Click OK to save and exit. 

 

Figure 70 Time Setup 

9.2.7. Touchscreen Calibration 
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Operating Procedure: 

1. Press  . 
2. Click Misc Setup. 
3. Click Touchscreen Cal. 

9.3. LAN Setup 
Operating Procedure: 

1. Press . 
2. Click Network Setup, the window is shown below. 

 
3. Edit IP Address、Subnet Mask, then press OK. 

9.4. Preset 
Operating Procedure: 

1. Press  . 
2. Click OK. 

9.5. File Manage 
With thisfunction, the user can copy files from the instrument to the U-disk. And the user can copy files from U-disk into the 
instrument, too. 

Operating Procedure: 

1. Press . 
2. Click File Manage. 
3. Insert the U-disk device. 
4. Select the files the user want to copy. 
5. Click the <<< or >>> button. 
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